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Menu Item Function 

Download 
language 

Enables downloading of the required language (English or Spanish) file 

Upgrade panels Automatically upgrades software of all Amber panels. 

 

UTILITIES

System
Audio

Download
Application

Download
Language

Download
Files Delete All Get Free

Space
 

3.6  Help Menu 
The Help menu enables you to receive information and guidance in managing HHCPC. 

Menu Item Function 

Help Topics On-line Help to increase your knowledge about HHCPC, and help you use it 
to its maximum potential. 

About HHCPC Provides HHCPC copyright and version information. Click on the HHCPC 
logo to display our Home Page, which contains important information about 
using HHCPC. 
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Chapter 4: Sites 
4.1  Introduction to Sites 

HHCPC enables you to manage Sites in a variety of ways. These features are accessible 
either from the menus or from the Site List window. 

The Site List window is displayed either when the program is first initiated, 
or by clicking the Sites button in the tool bar or by selecting List of Sites in 
the Sites menu.  

 
Figure 4-1: Site List Window 

This window displays a list of the site names whose files are located in the directory displayed 
in the Sites Location field. The first time the program is initiated, the path displayed will be 
the path where the HHCPC is installed on your computer. In later sessions, the Sites Location 
field will display the path last chosen (either typed in or selected using the Browse button). 
Using the Browse button, it is possible to locate and access a site file anywhere in the network 
and not just access site files saved to your local computer. 

Each column of the site list table can be sorted in either descending or ascending order by 
clicking on the column title. You can drag the vertical lines that separate the columns to 
enlarge or reduce the size of the columns. 
The screen displays buttons, which enable you to begin working with HHCPC: 

Button Function 
Open Opens an existing Site 
New Opens a new Site 
Delete Deletes a Site 
Exit Closes the HHCPC application. When you display the Sites List 

from within the system, the Exit button appears as a CANCEL 
button. This enables you to remove the Sites List from the 
screen, and continue using the application. 
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Button Function 
Browse Opens the Browse for Folder dialog box, which enables you to 

locate a folder where the Site files are located. 
Search Lists all the file names containing the text entered into the 

Search window. If "Look in sub directories" is not checked, the 
search will be performed only on Sites location (the root 
directory). 

4.2  Creating a New Site 
You can create a new, empty site file or you can copy an existing file, save it under a new 
name, and make the relevant changes to tailor it to a similar setup as the original. You can 
create a new site either via the Site List window or directly in the New Site window. 

1. Click New in the Site List window, 

 or 

 In the Sites menu, click New Site.… 

 The New Site dialog box appears.  

 

Figure 4-2: New Site Window - Work Online 

The New Site dialog box has two tabs:  

Work Offline: Enables defining and changing parameters offline and at a later time 
downloading these parameters to the control panel. 

Work Online: Enables direct operation with the control panel via a serial port or telephone 
modem.  

By default the New Site dialog box opens with the Work Offline tab open to enable you to 
create the configuration file before the installation.  



Sites ______________________________________________________________________4-3 

Working Offline 
Work Offline only if you know the Amber model you want to connect to. 

1. Select the Work Offline tab. The following screen will be displayed: 

 

Figure 4-3: New Site Window - Work Offline 

2. Select the relevant Amber model. 

3. Click OK. 

The HHCPC main screen will display the parameters relevant for the selected model. 

Working Online 

To work via a telephone modem 

1. In the New Site window click Options…. The Options Communications window 
appears. 
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Figure 4-4: Options - Telephone Modem Communications Mode 

2. Select Telephone modem in the Communications mode field. 

3. Ensure that the correct modem is selected and configured (see Chapter 9.1).   

4. Click OK. 

 The New Site window will appear displaying the Work Online tab with the 
Phone Number field enabled. 

 

Figure 4-5: New Site Window - Telephone Modem Mode 

5. Enter the Phone Number.  

 The Login button will become enabled. 
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6. Click Login. The Modem Dial Up... window will appear and attempt connecting. 

 
Figure 4-6: Modem Dial Up... 

7. Click Connect. The Hang Up button becomes enabled. 

 
Figure 4-7: Modem Hang Up 

8. Wait for two or three rings, then click the Hang Up button. 

 
Figure 4-8: Communicating with PC  
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The system will wait for 12 seconds and then will automatically dial again. The Amber 
will answer the call after the first ring and will initiate a data session with your PC. 

To work via a serial port 

1. In the New Site window click Options…. The Options Communications window 
appears. 

 
Figure 4-9: Options - Serial Port Communications Mode 

2. Ensure that Serial port is selected in the Communication mode field and that 
the serial port details are correct (refer to chapter 7: Connecting to the Amber 
Control Panel for further details). 

3. Click OK. 

 The New Site window will appear displaying the Work Online tab with the 
Phone Number field disabled. 
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Figure 4-10: New Site Window - Work Online via a Serial Port 

4. Click Login. 

4.3  Saving a Site  
From the Sites menu, select Save, or click the Save button on the toolbar; HHCPC 
automatically saves the site file on which you are working. 

When you select Save or click the Save button for the first time after creating a new site 
file, HHCPC displays the Save As screen. 

 
Figure 4-11: Save As... Screen 

4.4  Saving a Site File with a New Name 
This enables you to save the site file with a new name and in a different directory. 

1. From the Sites menu, select Save As; HHCPC displays the Save As 
screen.  

2. Enter a suitable name for the new site and locate the directory where you 
want to save the file. 
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4.5  Displaying and Editing Existing Site Files 
Once you have created a site, and saved it, you can view it at any time.  

1. Either select the site from the recently used files in the Sites menu or 
select the site name to display in the Sites List window, and click Open.  

2. The HHCPC main window displays the information of the selected site. 

3. Edit the site tables as necessary. 

4.6  Copying a Site 
You can create a new site based on an existing similar site. This is done by copying an 
existing site file, saving it with a new name and then making and saving the necessary 
changes. 

1. In the Site List window, select an existing site file. 

2. Click Copy; an edit box appears prompting you for the name of the new 
site.  

3. Type the new site name, then click OK. 

 The HHCPC main window appears and displays the details of the copied 
site. 

4. Edit the site as necessary. 

5. Click Save to save the site. 

4.7  Deleting a Site 
When a Site is no longer active, and it is no longer necessary to store it in HHCPC, you can 
delete it. 

1. In the Sites List, select the site to delete, then click Delete, a warning box 
appears reminding you that any account that you delete is not retrievable. 

2. Click Yes to delete the account, or No to return to the Sites List. 

 If you click Yes, the selected site is deleted and the Sites List is displayed. 

4.8  Exiting the Site List Window 
When you open HHCPC, the Sites List displays an Exit button. However, when you 
display the Sites List from within the application, the Exit button is replaced by a Cancel 
button. 

Click Exit to exit HHCPC.  

Click Cancel; the Sites List closes, and the main HHCPC screen becomes active. 
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Chapter 5: First Installation 
First Installation enables you to download configuration and specific customer audio files, 
and to set the date and time when the AmberNA performs initial connection to the HHCPC.  

5.1  Remote Reset  
The remote reset feature enables you to reset all configurations made to the AmberNA. 
When performing remote reset, the system saves all database and event log files. 

To Perform Remote Reset 

From the Communications menu, select Reset Control Panel, then select Remote Reset. 

5.2  User Test Mode 
The system enters this mode automatically each time the unit calls the central station. This 
enables the user to perform a Walk Test using an RF device. Each time the device button is 
pressed, the Base Station will announce the name of the customized audio file attached to 
the specific user name, or, it will announce the device type if no audio file was attached. 

If no audio file was attached, the AmberNA will announce the device type (pendant, smoke 
detector or fall detector) and its order number in the device table. 

At the end of the voice session, the AmberNA will report all activities to the central station 
log. 

5.3  Date/Time Updates 
After completing the first installation, the PC clock is updated to the correct date and time. 
The date and time are updated each time the HHCPC is logged into the unit. 

. 
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Chapter 6: Users 
From the Sites menu, select Users; HHCPC displays a menu that enables you to manage the 
HHCPC users. 
Menu Item Enables you to: 

Add new user Add a new user name and password. 

Delete user Delete a user. 

Change 
password 

Change an existing user’s password. 

Login as different 
user 

Login as a different user without exiting HHCPC. 

6.1  Adding New Users 
1. From the Sites menu, select Users, then Add new user; the Add new user 

dialog box will appear. 

 
Figure 6-1: Add New User Dialog Box 

2. In the User Name edit box, type the user's name. 

3. In the Password edit box, type the user's password. 

4. In the Confirm Password edit box, retype the user's password. 

5. Select the Full Access check box to enable the user to create and delete other 
users. If this is not selected, the user will have access to all the sites, but will not 
be able to create or delete other users. 

6. Click Add; a message box appears confirming the addition of the user to the 
system. 
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6.2  Deleting a User 
1. From the Sites menu, select Users, then Delete user; the Delete user dialog box 

will appear. 

 
Figure 6-2: Deleting User Name Dialog Box 

2. In the User Name edit box, type the user's name.  

3. In the Password edit box, type the user's password. 

4. Click Delete; a message box appears confirming the deletion of the user from 
the system. 

6.3  Changing User Passwords 
1. From the Sites menu, select Users, then Change Password. The Change 

Password dialog box appears. 

 
Figure 6-3: Changing User Password Dialog Box 

2. In the User Name edit box, type the user's name. 

3. In the Old Password edit box, type the user's current password. 

4. In the New Password edit box, type the user's new password. 

5. Click Change; a message box appears confirming the user password change. 
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6.4  Login as a Different User 
1. From the Sites menu, select Users, then Login as a different user; the HHCPC 

Login screen appears. 

2. In the User Name edit box type the user's name and in the Password edit box 
type the user's password. 

3. Click OK; a message will appear to notify that the password has been changed 
successfully.  
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Chapter 7: Data Details Tables 
The data details tables display the parameters that can be uploaded from or downloaded to 
the Amber control panel. When first creating a site file, the values displayed are default 
values, which can be altered to suit the specific system.  

Use the arrow keys to navigate between the cells and focus on the different parameters, 
then click the left mouse button or press ENTER to edit the cell and change the values.  

HHCPC includes the following tables:  
• Site Information 
• Panel Definitions 
• Communications Definitions 
• Transmitters 
• Reminders 
• Event Log 
• Intruder 
• Diagnostics 

7.1  Site Information 
This section provides various types of information on HHCPC sites, including site 
connection and location details. 

Site Information - Displays general information about the site control panel. 

Base Station Name - The name of the station where the control panel is installed. This 
field receives the name of the detected Amber model by default. 

Address, City, State, and Zip Code - The complete address of the site. 

Base Station Phone - The telephone number which the HHCPC uses to connect to the 
control panel. 

Additional Information - Additional important information about the HHCPC site and 
facilities. 

7.2  Panel Definitions 
Panel Definition enables you to customize the control panel and adapt its characteristics 
and behavior to the requirements of the particular user. 

Standard Support – Select UL, Social Alarm or Disabled. 
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Operational Mode - Various operational modes used in HHCPC, as follows: 

• Single User is used for the configuration of up to 29 detectors, out of which 2 personal 
detectors (Pendant or Fall Detector).  

• Multi User is designed for use in institutions and enables you to enroll up to 29 
detectors. (Does not support Device Test Check or Reminders.) 

• Fire Only acts only as a fire alarm and is used in conjunction with most detectors 
except for personal detectors (for example, pendant and fall detectors). (Does not 
support Device Test Check and Custom Audio Files or Reminders.) 
Note: When moving between the above three operational modes, the data entered into 
the previous operational mode will become invalidated if it contradicts the conditions 
of the current operational mode. An error message will then appear on the screen. 

• Common Area enables you to enroll up to 255 detectors. The first 29 enrolled 
detectors may be of any type. Detectors 30 -255 must be personal detectors only. 
Note: When switching from the Common Area mode to any other mode (and vice 
versa), all data entered by the user will be deleted. 

Language – Select the unit language for LCD alignment.  

Time and Date Format – USA or Europe time and date format. 

Time Zone Gap – Set the difference in time (in hours) between the location of the HHCPC 
system and the location of the Amber (0 by default).  

Automatic Daylight Saving – Enables/disables automatic adjustment to daylight saving 
time, according to USA or European standards (see Time and Date Format). 

Keypad Sound – Keypad sound is always OFF. 

Trouble Announcement – Defines the duration of time for trouble announcements. 
Enables you to provide definitions for the following periods of time: daily, weekly, 
monthly and yearly 

Reminders Duration – The duration of time in which the reminder is sounded (0 - 5 minutes). 

Local Pendant Test - Enables/disables local pendant transmitter test. 

Inactivity Window 1 – Define first activity beginning and end times. 

Inactivity Window 2 – Define second activity beginning and end times. 

Panel Audio Name – Provides audio announcement of panel name. It enables you to select 
a (.aud) file to be downloaded.  

Fall Detector Warnings – The number of times that the Amber will announce "User Has 
Fallen" when the fall detector has been tilted to an angle lower than 60 degrees. 

Fall Detector Warnings Delay – the amount of time in between each announcement. 

Blink On Reminder – when enabled, the LCD will blink during a reminder.  
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Volume - Define the default speaker volume level. 

Intruder Mode - Enables/disables Intruder Mode. 

User Notification Field – Enable/ disable user notification. Used for social alarm standard 
support (see Standard Support field). 

Personal Emergency on Away – When set to Enable, a button press on an enrolled 
pendant reports an emergency event if the unit is in Home and Away mode. When set to 
Disable, a button press on an enrolled pendant reports an emergency event when the unit is 
set to Home mode only. 

Jamming Detection  – Select between "enable" and "disable". The user may wish to select 
Jamming Detection disable. This will cause the unit to become non-compliant to the 
selected standard support. 

7.3  Communications Definitions  
Communications Definitions enables you to set the telephone communication parameters to 
the requirements of the particular Site. The CPC feature provides recognition of call 
termination at the other end of the line.  

Outside Line Number – If relevant, the Amber adds this number to the dialed telephone 
number. 

Report Mode – The Amber reports emergency events to the central station and/or to a 
private telephone number. 

Report Non Emergency to CS - Enables/disables report of non-emergency events to the 
central station. 

CS Communication Protocol – Enables user to choose between Contact ID or Tunstall 
communication protocol to the central station. 

Primary User Account – After dialing Emergency Tel, enter this code at the prompt. 

Emergency Tel #1 – In the event of an emergency, dials the first stored emergency number. 

Secondary User Account – After dialing Emergency Tel, enter this code at the prompt. 

Emergency Tel #2 – In the event of an emergency, dials the second stored emergency 
number. 

Ring Time (minutes) – The period, in minutes, during which the central station can 
establish 2-way voice communication with the Amber (2 min. by default). 

Central Station Dialing Attempts – Number of dialing attempts to the central station. 
First call is to Emergency Tel #1; second call is to Emergency Tel #2 (16 by default). 

1st private – Dials first private telephone number. 

2nd private – Dials second private telephone number. 
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3rd private – Dials third private telephone number. 

4th private – Dials fourth private telephone number. 

Private Dialing Attempts - Number of dialing attempts to private telephone numbers. First 
call is to Private Tel #1; second call is to Private Tel #2 (4 by default). 

Private Report Cycle – The number of playbacks of a private message report during a 
single attempt. 

Contact Check Time – Schedules a daily “Contact Check” to assure that the base unit can 
communicate with the central station. The time is scheduled automatically by the HHCPC. 

Day Time Window – The daytime window settings for Warden mode. 

Retry Emergency Timeout – The period of time after which the unit will attempt to report 
an emergency event if the previous set of attempts failed. 

Staff Mode Timeout – The staff mode timeout settings for Care Home Mode. 

CPC Signal Detection – Select Enable or Disable to activate/deactivate the CPC 
termination of a call feature. This feature also enables the installer to adjust the CPC 
detection per telephone service provider.  

CPC Threshold Minimum (0 – 500 ms) – Define the minimum threshold time upon CPC 
recognition, in milliseconds, for disconnecting the telephone line.  

CPC Threshold Maximum (0 – 900 ms) – Defines the maximum threshold time upon 
CPC recognition, in milliseconds, for disconnecting the telephone line.  

Direct Link Tel #1 – Amber dials the telephone number stored in memory location 1. 

Direct Link Tel #2 – Amber dials the telephone number stored in memory location 2. 

Direct Link Tel #3 – Amber dials the telephone number stored in memory location 3. 

Call Button Tel – If defined, the unit will call this telephone number upon pressing the 
Call button. 

Voice Session on Emergency – Enables/disables voice session after reporting to the 
central station. 

Rings Before Data Session – The number of continuous incoming rings after which the 
unit automatically enters a data session. 

2 Way Voice Direction – The default settings for the voice communication with the central 
station. Select Full Duplex or Listen in. 

Remote 2W Voice Access – Enables/disables remote two-way voice access. 

User Code – The user code setting for remote two-way voice access. 

Equipment type – Equipment type setting for Tunstall CS communication protocol. 
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7.4  Transmitters 
This feature enables you to enroll up to 29 RF devices. 

Active – Notifies if the enrolled device is active or not active. 

Device Type – Select the device type 

RF ID # – Transmission ID number. 

Intruder - Click to select SECURE/NON-SECURE/DELAY for every detector. 

Name – Name displayed on particular RF device. 

Device Audio – Click to select the corresponding audio file to the particular RF device. 

Device Test – Determines the frequency of performing checks on the RF device. 
Current RF Level – The result of the current diagnostic test 
Previous RF Level – The result of the previous diagnostic test 
Note: To delete an RF device from the Amber, select Not Active from Entry Status. 

7.5  Reminders 
This feature enables you to set up to 16 programmable reminders per day. The reminder is 
announced by a voice message and also appears on the Amber LCD display. 

Active – Notifies if the enrolled device is active or not active. 
Reminder Schedule – Enables you to set a recurring reminder: daily; weekly; monthly; or 
yearly. 
Reminder Type - Select one of the following reminder options: 

• Medication  

• Health Test  

• Wellness Check 

• Wake Up Call 

• General Reminder  
Note: Up to 16 programmable reminders.  If a specific reminder is ignored for the duration 
of the reminder (programmable under Panel Definitions), an emergency announcement is 
sent to the central station and a 2-way voice session is opened. 
User Name – Displays the name of the person to whom the reminder is intended. 
User Name Audio – Provides a voice message emitting the user name. 
Displayed Message – Displays the contents of the message. 
Audio Message – Provides a voice message that relays the contents of the message. 
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7.6  Event Log 
The Amber maintains a log file of all occurred events. The event log can be uploaded to the 
HHCPC. 
Index # – Lists events in numerical order. 
Event – Type of event. 
Zone # – Displays the wireless device number or whether it was a system event. 

Date and Time – Displays the date and time of the event. 

To upload the event log table 

1. Perform login. 

2. Select the Event Log table. 

3. Click the Get Table icon on the toolbar 

The HHCPC uploads all events in the table. A log file can contain up to 100 events in FIFO 
format (first-in, first-out), whereby new events overwrite the oldest events.   

7.7  Intruder Mode 
This mode enables you to perform the functions listed below. 

Arm/disarm from Panel – Enables/disables arm/disarm function on AMBER control 
panel, by pressing the CHECK button for 3 seconds 

Entry delay – Entry delay value. 

Exit delay – Exit delay value. 

Swinger counter – Disabling or setting the swinger counter. This counter determines how 
many times (1, 2, 3, or disable) each zone is allowed to initiate an alarm within a single 
arming period. If the alarms number from a specific zone exceeds the programmed number, 
the control panel automatically bypasses the zone to prevent recurrent siren noise and 
nuisance reporting to the central station. The zone will be reactivated upon disarming. 

Silent Alarm – Enables or disables the silent alarm. This is used in Wandering patient 
applications. The delay beep operates as normal, but the siren will not be activated in the 
event of an alarm  

Siren – Siren activation duration value. 

Voice Session on Alarm - Enables/disables a voice session after the activation of an alarm. 

Chime - Enables/disables the Chime function 
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7.8  Diagnostics* 
Diagnostics provides details of the control panel and items connected to the control panel. 

Control Panel Serial Number – Production serial number of control panel. 

Flash Version -  

Control Panel Software Version – Current software version of control panel. 

Control Panel Hardware Version – Current hardware version of control panel. 

Control Panel Manufacture Date Code – Special code unique to each Amber unit. 

Pendant ID – Pendant ID number. 

Feature support -  

Power Charger Status – Provides battery life status. 

• All parameters are read-only. Diagnostics parameters are updated when uploading tables. 
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Chapter 8: Utilities 
8.1  Translation Editor 

HHCPC enables you to perform text changes to the control panel in a variety of ways. 
These features are accessible from the Utilities menu. 

The Translation Editor window is displayed by selecting Translation Editor in the Utilities 
menu. The text that appears on the Amber window is comprised of two rows, with up to 16 
characters on each row. Rows marked in gray cannot be edited. Rows marked in purple 
may be edited only where there are no asterisks. 

 
Figure 8-1: Translation Editor Window 

8.2  Editing Control Panel LCD Display Strings 
This window enables you to edit the strings on the LCD display and also to translate the 
strings from English into a different language. 

1. Click the Def button to upload the LCD string definitions file (usually titled 
language.def). 
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Figure 8.2: Translation Editor Window – Typing Text 

2. Click the Lang button to load an existing file to be edited, by selecting the 
required (.lng) file from the opened window, 

or 

Simply type the required text in the empty rows. 

 
Figure 8.3: Translation Editor Window – Editing Existing Text  

3. Edit the file, as required. 

4. Click the Save button. 

5. From the Utilities menu, select System Files, then Download Language.  

6. Download the relevant (.lng) file. This will update the control panel LCD 
display strings. 

Definition  
of text on  
LCD display 

Text that  
appears on  
LCD display 

Definition  
of text on  
LCD display 

Text that  
appears on  
LCD display 
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8.3  Software Upgrade 
HHCPC enables you to automatically upgrade Amber control panels. 

1. From the Utilities menu, select Upgrade Panels; the Software Upgrade dialog 
box will appear. 

 
Figure 8.4: Software Upgrade Dialog Box  

2. In the Telephone number List File section of the dialog box, click the Browse 
button and select the file containing the control panel's telephone number. 

3. In the Application File section of the dialog box, click the Browse button and 
select the .hex file to be downloaded. 

4. In the Extra dialing information section of the dialog box, enter the prefix used 
before dialing the telephone number, if required. 

5. Click the Start button; HHCPC begins to automatically upgrade all the Amber 
control panels in the system. 

Note: Click the Stop button to end the automatic upgrade procedure. To 
temporarily stop the procedure, click the Pause button, then click the Start 
button again to resume. 

6. When the procedure is completed, click the Exit button. 
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Note: The telephone file format is as follows:  

• A line must not exceed 256 charters. 

• A line should always display the telephone number (0-9 plus the character '-') 
first, then any additional text. Each telephone number is restricted to a 
maximum of 16 digits. 

• After inserting the telephone number, there must be a space, after which you 
may insert a remark, if desired. 

The following table provides a list of possible statuses that appear in the file while the 
software upgrade procedure is running. A status appears at the end of each row 
immediately following "####". 

Status Definition  
OK  Procedure completed OK  

COMM ERROR Communication error during download 

NO ANSWER Control Panel did not answer 

BUSY A busy modem signal received 

NO CARRIER Control Panel did not answer 

NO DIAL TONE No telephone line is connected to modem 

USER CANCEL User stopped the procedure 

GENERAL ERROR Modem error 

<empty> Not processed yet 
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Chapter 9: Connecting to the Amber 
Control Panel 

Connecting to the Amber control panel enables the HHCPC to transfer information to and 
from the control panel. The control panel can be connected by remote connection (via 
telephone modem), used when the operator specifies the parameters off-site, or by local 
connection (via RS-232), used when the installer uses a PC to specify the parameters 
on-site.  

Once connected, it is possible to perform a number of operations, such as, uploading site 
parameters, downloading site parameters or changing system date and time.  

9.1  Defining Communication Settings 
The Communications dialog box enables you to determine the communication settings by 
which the HHCPC and the control panel will communicate. 

From the View menu, select Options, then click on the Communications tab; the 
Communications dialog box appears. 

 
Figure 9-1: Options - Communications Tab 
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9.1.1 Local Connection (Serial Port)  

Local connection is used when the HHCPC is within direct cable connection distance from 
the Amber control panel. When using Local Connection there is no need for a modem. Only 
communication ports without installed modem drivers may be used in Serial mode. For 
example, if the modem drivers are installed on the ports COM2 and COM3, then ports COM1 
and COM4 may be used for connection in Serial mode. 

1. From the Communications mode drop-down list, select Serial Port. The serial 
port parameters are displayed as follows: 
• The Comm port field becomes enabled. 
• The Baud rate field displays 115200, this being the baud rate used for serial 

connection. The Baud rate field is disabled. 
• The Parity and the Stop bits fields do not change and are disabled. 

 
Figure 9-2: Communications Mode - Serial Port 

2. Change the Comm port field as necessary. 

3. Click OK. 
  

9.1.2 Remote Connection (Telephone Modem)  
This is applicable when the HHCPC is off-site and when using a telephone modem to connect 
to the Amber on-site. 

1. From the Communications mode drop-down list, select Telephone Modem. 
The telephone modem section becomes enabled, and the serial port parameters 
change automatically to be displayed as follows: 
• The Comm port field becomes disabled and the field value is the 

communications port where the modem is connected. 
• The Baud rate field displays 115200, the baud rate used for telephone modem 

connection. 
• The Parity and the Stop bits fields do not change and are disabled. 
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Figure 9-3: Communications Mode – Telephone Modem 

2. In the Telephone Modem section of the dialog box, select from the Modem 
drop-down list, the modem to use for connecting to the control panel. 

3. Click Settings to display the Modem Settings dialog box, and define the dialing 
and modem parameters. 
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Figure 9-4: Modem Settings 

4. To connect to the Amber modem, the local software initiates the dialing process. 
This process includes a number of steps: 

 Step 1: Dialing. 

 Step 2: Waiting 2-4 rings (The dialing process ends if connection is made). 

 Step 3: Hanging up. 

 Step 4: Waiting a number of seconds before trying again. 

 Step 5: Beginning the dialing process again for the predefined duration of time. 

 The Try to connect field defines the number of times the dialing process should 
be initiated (step 1-4). The Wait for 2-4 rings during field defines the time 
allocated for the two to four telephone rings (step 2). This time needs to be 
defined as different telephone systems/modems take different amounts of time to 
carry out the rings. 

 Tip: If you are not sure of the time to enter in the Wait for 2-4 rings during 
field, enter a high number (i.e. 100 seconds), initiate connection as detailed in 
the section Remote Connection in this chapter, time on your watch the number of 
seconds your modem takes for 2 rings and then click Hang Up. Enter the number 
of seconds you timed in the Wait for 2-4 rings during field. 
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The Wait for connection during field defines the duration of time (in seconds) 
for connection once dialing begins again (step 5). 

9.2  Connecting to Amber 
The login procedure enables HHCPC to transfer information to and from the control panel 
and can be initiated either when creating a new site file or when a site file is already open. 
This procedure differs when the communications mode is set to Serial Port or Telephone 
Modem. The first part of the procedure is the same for both types of communication 
modes: 

To Login when creating a new site file  

1. Select New Site from the Sites menu, 

 Or 

 Click New in the Sites window. 

2. In the New Site (work online) dialog box, fill in the fields (the fields will be 
enabled/disabled according to the communication mode). 

3. Click Login. 

To Login when a site file is open 

From the Communications menu select Login, 

Or  

Click the Login icon in the toolbar. 

Performing Local Connection (Serial Port)  
After connecting, the communication icons in the status bar will become green, and the 
Download and Upload icons in the toolbar become enabled and you have successfully 
logged in. 

9.3  Online Operations 
While connected to the Amber, it is possible to perform a number of different operations. 
You can transfer information between the HHCPC and the control panel by uploading or 
downloading, either all site parameters or a specific table. It is also possible to update the 
system date and time. 
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To Download or Upload All Site Parameters 

From the Communications menu, select Download or Upload,  

Or 

Click the appropriate icon on the toolbar.  

The system begins to transfer data between the control panel and the HHCPC. The wording 
on the message box changes according to whether the transfer is upload or download. 

 
Figure 9-5: Uploading/Downloading Progress Bar Screen 

At any point during the transfer, you can click Cancel to halt the procedure. 

When the transfer is complete, a message box appears to confirm successful completion. 

To Download or Upload a Specific Table 

1. Select a table by clicking on a table name in the List of Tables area, or by 
clicking a table tab at the bottom of the screen. 

2. From the Communications menu, select Send Table or Get Table, or click the 
appropriate icon on the toolbar.  

Using the Audio manager 

The Audio Manager handles all custom audio files for each control panel. 

1. From the Transmitters and Reminders tables, select the custom audio (.aud) files to 
be included in the control panel. 

2. From the Communications menu, select Audio Manager; the Audio Manager 
dialog box appears. 

3. Select the custom audio files you wish to download and click the Download button 
to download the files. 

4. Click the Delete All Files button, to delete all custom audio files from the Amber. 

5. Click the Get Free Space button to send a query to the Amber of the amount of 
space available in the custom audio. 



Connecting to the Amber Control Panel ___________________________________________9-7 

Note: The Download, Delete All Files and Get Free Space buttons are enabled only 
after performing login. 

 
Figure 9-6: Audio Manager Dialog Box 

5. A gray icon and Waiting status indicates the file has not been downloaded to the 
Amber. A yellow icon and Loaded status indicates the file has been downloaded 
to the Amber. 

6. Click the Close Window button to close the audio manager dialog box. 

Note: See the Utilities menu for other functions which are performed online. 

9.4  Disconnecting from the Amber 
From the Communications menu, select Logout,  

Or 

Click the Logout icon on the toolbar. 
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Chapter 10: Data 
The data tab is used to define specific upload/download settings to facilitate data transfer.  

10.1  Defining Data Settings 
The Data dialog box enables you to customize specific data settings in the 
upload/download process. 

From the View menu, select Options, then click on the Data tab; the Data dialog box 
appears. 

 
Figure 10-1: Options – Data Tab 

1. Select the Send updated data immediately check box, to automatically update 
changed settings from the HHCPC to the Amber. 

 Note: If the above check box is not selected, the Amber will only be updated 
when performing full download. 

2. In the Delay after acknowledge during download field, enter a time value (in 
milliseconds) for a delay in sending commands.  

Note: This field should be used when problems in communication are experienced. 
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Chapter 11: Reports 
After you have created a site, you can generate a printable report of the site data. To 
generate a report, first define the information to include in the report, then preview the 
report and then print it. 

11.1  Defining and Generating a Report 
Each HHCPC account comprises of 7 tables. You can generate a report including 
information about some or all of these details. After you specify which details you require 
in the report, HHCPC will generate the report. 

To Define and Generate a Report 

1. From the View menu, select Options, or  

 Click the Options button on the toolbar; the Options dialog box appears. 

2. Click the Reports tab; the Reports dialog box appears. 

 
Figure 11-1: Options – Reports 
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Select the relevant check boxes to specify the information to include in the Report. 

3. Click Apply; the tables to include in the report are selected, and the Reports 
dialog box remains on the screen for further perusal and selection. 

4. Click OK; HHCPC generates the report according to your specifications. 

11.2  Viewing a Report 
HHCPC enables you to view reports before you print them. This enables you to check that 
all necessary information has been included in the report. 

To View a Report  

From the Sites menu, select Print Preview. 

HHCPC displays the report of the site as specified for printing via the Options dialog box. 
This enables you to view the various details of the report before you print it. 

The Print Preview toolbar enables you to do the following: 
Print Prints the report from the Print Preview screen. 
Next Page Displays the following page of the report. 
Prev Page Displays the previous page of the report. 
First Page Displays the first page of the report on the screen. 
Last Page Displays the last page of the report on the screen. 
Whole Page Displays one page of the report on the screen. 
Page Width Fits the page to the width of the window. 
Two Pages Displays two pages of the report on the screen. 
Thumbnail Opens a navigation pane of thumbnails of each report. 
Zoom  Increases the size of the report as it appears on the screen. There 

are five possible view sizes available. 

11.3  Printing a Report 
You can change the print setup for a report. This enables you to determine the following: 
• The printer to print the report. 

• The paper size on which to print. 

• The source from which the printer should take paper. 

• The orientation of the paper. 
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To Determine the Print Setup 

1. From the Sites menu, select Print Setup; the Print Setup dialog box appears. 

2. Specify the printer to where the report will be printed. 

3. Specify the paper size of the paper on which the report will be printed. 

4. Specify the paper source. 

5. Specify the orientation of the paper. 

6. Click OK. The window is closed. 

To Print a Report 

1. From the Sites menu, select Print (or click the Print button on the toolbar); 
HHCPC displays the Print screen.  

 
Figure 11-2: Print Dialog Box 

This screen enables you to do the following: 

• Select the printer to print the report. 

• Determine the print range. 

• Determine the number of copies of the report, and whether or not they should be 
collated. 

2.  Make the appropriate changes, then click OK; HHCPC prints the report. 
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Chapter 12: Screen Appearance 
Any changes to the appearance of the Site screens are made in the Display tab of the 
Options dialog box. 

 
Figure 12-1: Options - Display Tab 

12.1  Changing the Color 
The colors of the Table Details are defined according to the following settings: 

• Table zebra color: Defines the color of every other line in each table. This makes it 
easier for the user to follow the horizontal lines in the table.  

• Table disabled option color: Disabled tables appear in the selected shade. 

• Table normal option color: The color of the text as you type it. 

• Background color: The background color of the tables list and the sites list. 

To Change the Tables Color 

1. From the View menu, select Options; the Options dialog box appears. By 
default, the display tab is active. 

2. Click on the block of Tables zebra color; the color palette appears. 

3. Select a color, then click OK. 

4. Repeat the procedure for all the options. 

5. Restart HHCPC. 
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12.2  Column Alignment 
HHCPC defines the Table Details column alignment according to one of the following 
settings: The Tables Column Alignment determines the width of the table columns on the 
screen. 

• No auto alignment: All columns in the tables are the same width, regardless of their 
contents. 

• Right justified: The columns in the table are all widened in order to cover the entire 
screen. 

• Last column stretched: The last column in the table reaches the right side of the screen, 
however wide the contents of the column. 

• Additional column: An additional column is added to the tables that are too narrow to 
fill the screen. The extra column is the width of the empty space between the last 
column of the table, and the right side of the screen. 

To Change the Tables Column Alignment 

Click the column alignment drop-down arrow, then select an option from the list. 

12.3  User Interface Language  
HHCPC provides you with the possibility to change the language used in the software 
interface.  

To Change the User Interface Language 

1. Click the Language User Interface language drop-down arrow, then select a 
language from the list.  

2. Restart HHCPC. 
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Chapter 13: Troubleshooting 
PROBLEM DIAGNOSIS POSSIBLE SOLUTION 

A.  The HHCPC 
doesn't identify the 
modem 

A1. Your modem 
might be OFF or 
loosely 
connected.  

A1. Make sure the modem is turned ON. A 
power switch is available on any external 
modem. The light on the front panel should 
illuminate.  
Also ensure that all other applications using 
the COM Port are turned off (PalmPilot 
Hotsyc and other accessories or terminal 
windows). 
Check whether the cable connectors are 
fitted securely to their respective ports: 
• The line connector in case of an internal 

modem  
• The line and RS-232 connectors in case 

of an external modem.  
 A2. You may have a 

COM\IRQ 
conflict. 

A2. Check whether you have the correct Com 
port and IRQ settings in your software 
and/or in the Windows Control Panel. Also 
verify that there are no conflicts with other 
devices. 

B.  Failure to com-
municate with the 
Amber via the 
modem.  

B1. You may have a 
conflict with the 
definitions in the 
communication 
mode window. 

B1. Make sure you selected the Telephone 
Modem option in the communication mode 
window.  

 B2. The modem type 
is different from 
the type displayed 
in the OPTIONS 
menu / Com-
munications tab. 

B2. Check that the correct modem type has been 
selected. 

 

 B3. Modem is not 
properly installed 
in operating 
system 
(Windows). 

B3. Make sure that the modem is recognized by 
Windows.  

  If not, click Start → Setting → Control 
Panel. Double click the Modems icon and 
follow the instructions on the displayed 
Install New Modem window. 
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PROBLEM DIAGNOSIS POSSIBLE SOLUTION 
 B4. Amber is not 

connected to the 
phone line. 

B4. Verify proper connection of the Amber to the 
phone line. 

C.  PC fails to 
communicate with 
the Amber via the 
Serial Port.  

C1. The RS-232 cable 
is disconnected 
from the Com 
Port of your PC. 

C1. Verify proper connection of the RS-232 
cable.  

 C2. You may have a 
definition conflict 
in the OPTIONS 
menu/ Commun-
ications settings 

C2. Make sure that the Serial Port option is 
currently selected. 

 

 C3. Your serial port is 
defined to work 
with high or low 
baud rate. 

C3. Make sure 115200 bps option is currently 
selected in the OPTIONS menu / 
Communications.  

 C4. You may have a 
COM Conflict. 

C4. Verify that the correct Com Port is specified 
in the OPTIONS menu / Communications 

D.  The unit stalls 
during 
configuration or 
remote 
programming. 

D1. The Amber needs 
to be reset. 

D1. Press the three main buttons on the Amber 
simultaneously, for 10 seconds. 
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Appendix A: Language Settings 
When using the HHCPC Software in Windows 2000/XP with a foreign language interface, 
some characters may not appear correctly in the chosen language. This may require 
changing the language settings. 

Changing Language Settings in Windows 2000 

1. From Start>Settings>Control Panel double-click Regional Options. The 
Regional Options dialog box appears. 

 
Figure A-1: Regional Options Window 

2. Click Set Default; the Select System Locale dialog box appears. 

 
Figure A-2: Select System Locale Window 
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3. Click the drop-down list and select the appropriate language. 

4. Click OK. 

5. Restart the computer. 

Changing Language Settings in Windows XP 

1. From Start>Settings>Control Panel double-click Regional and Language 
Options. The Regional and Language Options dialog box appears. 

 
Figure A-3: Regional and Language Options Window 

2. Click on the Advanced tab. 

3. Under Language for non-Unicode programs, click the drop-down list and 
select the appropriate language. 

4. Click OK. 

5. Restart the computer. 
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